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1 Introduction 
 
The Electronic Document Information System (EDIS) is a document management system 
which supports the United States International Trade Commission (USITC). EDIS is a 
repository of electronic files and the electronic images of paper documents that comprise 
the official record of all investigations conducted by the USITC including those of the 
Office of Investigations, which processes investigative documents; of the General 
Counsel, which use the system for litigation support and legal research; Unfair Import 
Investigations; the Administrative Law Judges; and other Offices, which use the system 
for legal and other research. 
 
The USITC receives many documents from law firms, from entities concerned with trade, 
and from the public. In addition, documents are filed in EDIS by USITC in response to 
investigations and other document filings. 
 
Users can file documents with USITC by paper or by electronic filing. EDIS provides an 
online form for the generation of cover sheets, which are saved in EDIS awaiting the 
delivery of the hardcopy document. For electronic filings, the user can enter the 
document information and attach the document directly for submission to USITC. 
 
The USITC Dockets Office accepts the paper documents with an EDIS cover sheet and 
then scans and indexes the document into EDIS. The Dockets staff checks the document 
and data for accuracy, rules compliance and further quality checks. The document is then 
stored in EDIS.  
 
Electronic documents (Adobe Acrobat PDF format only) are submitted via the Web, 
checked for accuracy and rule compliance, and stored into EDIS.   
 
Public documents which have been filed can be viewed via the Web, saved, and printed. 
Confidential and other restricted documents cannot be viewed externally.  Authorized 
internal users only can search for Confidential and higher security level documents.  
 
The suite of EDIS products consists of: 
 

• EDIS II (Legacy) consists of an internal user EDIS Web Gateway, plus the 
HighView Client application to approve and process the received documents.  

 
• EDIS Public Search Application consists of a public search interface for EDIS 

documents. Public documents and Confidential cover sheet data (metadata) can be 
searched by internal and external users. No userid is required to access this search 
tool. 

 
• EDIS E-Filing consists of a web application for document submission to EDIS.  

Userids are necessary to login to this application, and can be established using the 
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registration page. The Daily Filing Report and Service List Utility are also 
provided. This application is described in this User’s Guide. 

 
This User’s Guide provides guidance to internal and external users on the features 
available in EDIS E-Filing 1.1. Rules governing the electronic submission of documents 
to USITC can be found in the Handbook for Electronic Filing Procedures.  Rules cited in 
the Handbook for Electronic Filing take precedence over this User’s Guide. With this 
release of EDIS E-Filing, external users will no longer need access to the EDIS Web 
Gateway. Internal users may still need access to the EDIS Web Gateway in order to 
search for secure documents. 
 
The responsible organization for EDIS is: 
United States International Trade Commission (USITC) 
Office of the Chief Information Officer 
Mr. Stephen McLaughlin, CIO  
500 E Street, SW 
Washington, DC  20436 
Phone: (202) 205-3131 
stephen.mclaughlin@usitc.gov
 
System Owner / Program Manager 
Office of Information Technology System Director 
Mr. Brian Moran 
USITC 
500 E Street, SW, Room 412-A 
Washington, DC 20436 
Phone: (202) 205-2784 
Fax: (202) 205-2024 
Brian.moran@usitc.gov
 
EDIS System Administrator / Help Desk 
Dockets Office 
USITC 
500 E Street, SW, Room 112 
Washington, DC 20436 
Phone: (202) 205-EDIS (3347) 
 

1.1 References 
Documentation is online within the EDIS E-Filing application. The following 
documentation is currently included, and will be updated as necessary. 
 
User Documentation: 
 

Title Version Date Location 
Who Should Register 1.0 February, 2006 Online 
EDIS E-File Training Presentation - March 17, 2006 Online 
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Frequently Asked Questions 1.0 December, 2005 Online 
EDIS E-File User’s Guide  1.1.7 July 24, 2006 Online 
Handbook for Electronic Filing Procedures Update March 24, 2006 Online 
 EDIS RSS User’s Guide 1.0 March 22, 2006 Online 
Handbook for Electronic Filing Procedures – 
Federal Register

Vol 71, No. 62 March 31, 2006 Online 

How to File a Paper Document 1.0 December, 2005 Online 
How to File an Electronic Document 1.0 December, 2005 Online 
Tips for Print Publishing Support 1.0 December, 2005 Online 
Help for 337 Filings 1.0 December, 2005 Online 
Help for Import Injury Filings 1.0 December, 2005 Online 
    
Field Level Help 1.1 May, 2006 Online 
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2 Overall Description 
 

2.1 Getting Started 
The EDIS E-Filing system is a web application. Any of the current popular web 
browsers, such as Internet Explorer, Netscape, or Mozilla Firefox can be used to access 
the application. Older versions of these browsers may not support all of the features of 
EDIS E-Filing. Standard web browser navigation is used in the web application. The 
application does not require any workstation installations, other than Adobe Acrobat. An 
appropriate PDF converter, such as Adobe Acrobat Standard, Acrobat Professional, 
Acrobat Print interface, or other vendor converter tools, can be used to create the PDF 
documents for submission. Acrobat Reader is required to view documents and is 
available as a free download. 
 
To access EDIS E-Filing, select the Electronic Document Information System (EDIS) 
and Electronic Docket menu option on http://www.usitc.gov.  Select the EDIS E-Filing 
link. This will display the main EDIS E-Filing web page as shown in Figure 1 - Main 
EDIS E-Filing Menu. 
 
A link is also available for internal users via the ITC_Central intranet.  
 
The direct link is: https://eofpub.usitc.gov/edis-efile/app . 

2.2 General Navigation 
Users will access EDIS E-Filing by using a web browser. There are some differences in 
the web page behavior between different browsers.  
 
Functional links have appearances as Links (underlined, highlighted words), or as action 
buttons. Help icons are links to the field help text. Clicking on these options will direct 
you to another web page or popup. 
 
There is an EDIS Tools menu in the upper right portion of the web page. This menu will 
allow you to select the available options within EDIS E-Filing. These options include a 
Help option, main menu, reporting options and search. Selecting the Search option will 
end your login session with EDIS E-Filing.  
 
Please refrain from using the Back and Forward Browser buttons. The application 
contains data and processing that must be handled between the pages. Use buttons and 
links provided within the application to navigate to other pages. 

2.3 Main 
 
The EDIS Main Menu provides a list of options where the user may: 

• Read About the Changes 
• Login 

Print Date: 7/18/2006 8 

http://www.usitc.gov/
https://eofpub.usitc.gov/edis-efile/app


  EDIS E-Filing 1.1 User Guide 

• Register (new users) 
• Search EDIS documents 
• Link to EDIS II Legacy Application (available only to internal users) 
 
On the EDIS Tools Menu, there are links to: 

• Home (this menu) 
• Search (Public Search Application) 
• Help (User’s Guide, Federal Register Notices, Quick Help, Training) 
• Register  
• Login 
 

Additional links are provided to access FirstGov, Privacy Policy and to submit 
comments to USITC regarding the application. 
 

 
Figure 1 - Main EDIS E-Filing Menu 

 

2.4 Main Menu after Login 
Once the user has successfully logged in, the Main Menu will be displayed, see Figure 2 
- Main Menu after Login.  The user may select the following options: 

• Read About the Changes 
• E-File Documents – submit electronic documents (PDF files) 
• File Documents (Paper Only) – submit paper documents by creating a coversheet. 
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• Service List 
• Daily Filing Report 
• Change Password 
• Access EDIS (Legacy System) – (available only to internal users) 

 
The EDIS Tools menu, there are links to: 

• Home (this page) 
• Search – Search Application page 
• Help 
• Log out (end this user’s session) 
• Change Password 
• Service List 
• Daily Filing Report 
• Access EDIS (Legacy System) – (available only to internal users) 
• RSS Feed Generator – (available only to internal users) – immediate notifications 

of incoming documents. 
 

 

 
Figure 2 - Main Menu after Login 
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2.5 Help 
Several resources are available for Help with EDIS E-Filing functions.  

• Error Messages 
• Field Level Help 
• Online Help Documents 

o User Guides 
o Notices (Handbooks and Federal Register Notices) 
o Tutorials 
o Quick Help Guides 

 
These resources are defined in more detail in the following sections. 
 
If you are encountering difficulties using EDIS E-Filing after reviewing these resources 
then contact the EDIS System Administrator at (202) 205-EDIS (3347). 
 

2.5.1 Error Messages 
Error messages are displayed to the user if incorrect values are entered.  If there is a 
problem with data in a particular field, the field will be highlighted with a red label and 
**, such as shown in the example below, see Figure 3 - Error Identification. 

 
Figure 3 - Error Identification 
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2.5.2 Field Level Help 
Field Level Help is available on most fields by clicking on the Question Mark icon .  A 
popup box will be displayed containing a description of the field, see Figure 4 - Sample 
Field Level Help.
 

 
Figure 4 - Sample Field Level Help. 

 

2.5.3 Online Help Documents 
A repository of documentation is available to assist users in proper document filing.  See 
Figure 5 - Help Menu below. 
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Figure 5 - Help Menu 

This User’s Guide is posted on the Help Menu for reference.  
 
Federal Register notices and other announcements affecting the electronic filing of 
documents in EDIS are posted on the Help Menu. 
 
The EDIS E-Filing Training Presentation is posted in PowerPoint on the Help Menu to 
provide introductory guidance regarding the usage of EDIS E-Filing.  Microsoft 
PowerPoint or PowerPoint Viewer is required to view the presentation. 
 
Specific Document Submission quick help guides are also included in the Help Menu. 
 
For internal USITC users, the EDIS RSS User’s Guide is available to provide instructions 
on how to set up and use the EDIS RSS document feed to receive notifications of new 
document submissions. 

2.6 User Access 
All users of EDIS E-Filing must be registered and login to use the system. Users of the 
Public Search Engine are not required to login. Users will need additional authorizations 
by the Office of the Secretary to use the EDIS II WebSite.  
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2.6.1 User Authentication Rules 
The following rules apply to userids and passwords. The same rules apply for 
Registration, Login, Change Password and Forgot Password functions. 
 
The userid can be selected by the user at registration. If the userid is in use, another will 
need to be selected. The userid when entered on the login screen is not case-sensitive. 
The userid can be a maximum of 20 characters. 
 
The password must be at least 8 characters in length and contain Upper or Lower case 
letters, Numbers and Special Characters (!@#$ etc.). The maximum password length is 
30 characters. Spaces are not allowed. You will need to enter your password twice to 
verify the correct spelling, when registering or changing your password. 
 
Valid Password Examples: 
 Hb01Mar* 
 Bb000001@ 
 Pop9090!! 
 
Invalid Password Examples: 
 Aaaaaaaaa12 
 12345678* 
 ABCD4444 
 
All users must change their passwords every 180 days or the account will be disabled. 
Two weeks prior to the expiration of the password, you will receive an email notice, as 
well as a notice when logging into EDIS E-Filing, that your account will expire. You will 
need to change your password to keep your account active. On the 180th day, you will 
receive another email and notice that your password has expired and you cannot access 
EDIS E-Filing unless you change your password immediately. Seven days later your 
account will be locked, and can only be reactivated by contacting the EDIS System 
Administrator.  
 
To change your password after receiving these email notices. Go to EDIS E-Filing, 
LOGIN, and select CHANGE PASSWORD. 
 
If you do not use your account for 180 days, the account will be marked Inactive and 
require the EDIS System Administrator to reset it. 
 
Entering the incorrect password three times for the userid will result in locking the user 
account. The account can only be unlocked by contacting the EDIS System 
Administrator.  
 
If the user has forgotten the password, the Forgot Password option will enable the user to 
reset the password to the codeword selected at registration. Once the codeword is entered 
successfully, the user will be required to change the password to a new password. 
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The user’s account can be terminated by notifying the EDIS System Administrator that 
the user is no longer working with a particular firm or organization, or is no longer 
employed by USITC. The USITC may terminate a user’s access at any time if misuse of 
the system is suspected. 

2.6.2 Register  
Users wishing to submit documents via EDIS E-Filing must have a user account. The 
account is obtained by completing an online registration. When submitting documents, 
the name associated with the user account must be signature name on the documents 
being filed. In other words, the attorney filing the documents via EDIS E-Filing must 
create the user account with their full name. The name on the registration page must 
match the user’s normal signature. 
 
Therefore, for external users, the attorney submitting the investigative materials must 
register, and then may provide their userid and password to their legal staff to submit 
documents on the attorney’s behalf. The attorney is ultimately responsible for the 
submissions made. 

2.6.2.1 Terms of Use Agreement   
The first step when registering is to accept the Terms of Use Agreement, see Figure 6 - 
Registration - Terms of Use Agreement. Please read the text and acknowledge acceptance 
of the conditions to use EDIS E-Filing. 
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Figure 6 - Registration - Terms of Use Agreement 

 

2.6.2.2 Registration Form 
The Online User Registration form must be filled by the user to submit a request for a 
EDIS E-Filing user account. The form has slightly different fields depending on whether 
the user is registering internally to USITC or externally. The determination of internal vs. 
external is based on the user’s IP address at the time of registration. 

2.6.2.2.1 External User Registration 
External users will see a registration screen as shown in Figure 7 - Registration - 
External User.   
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Figure 7 - Registration - External User 

Enter your full name as you would sign documents that you are submitting to USITC. 
When submitting documents, the signature names will need to match the registered name 
on the account submitting the documents. 
 
Select your Firm / Organization. The registered address for your firm will appear. If the 
address information does not match your location information, edit the fields on the form. 
 
If your Firm/Organization is not shown in the dropdown list, select ‘Not Listed’. You will 
be prompted with a popup form requesting that your Firm / Organization be added to 
EDIS. On pressing SEND, the information will be sent by email to the EDIS System 
Administrator. The user should continue with registration using ‘Not Listed’ as the 
Firm/Organization. The System Administrator will review the request and add the 
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Firm/Organization to the list. The user’s account will also be updated to reflect the newly 
added Firm/Organization.   
 
If your Firm/Organization is not listed, you are not representing a party to an 
investigation and you expect to be a casual user of EDIS E-Filing, please select ‘Not 
Applicable’ instead of ‘Not Listed’. 
 
Verify or insert your address information. State is not required if you reside outside the 
United States. 
 
Enter your telephone number so that you may be contacted directly if there is a filing 
error. Your fax number is optional. 
 
Enter a valid email address for the account being registered. This address will be used for 
responses and correspondence related to document submissions. If legal assistants and 
others will be filing documents on your behalf, you may wish to configure your mailbox 
to forward EDIS E-Filing messages to the staff acting on your behalf.  The email address 
must be a properly formatted email address, such as contains one @, and .gov, .com, .net 
or other country identifier. 
 
Enter your desired userid and password. An error will be noted if the userid has been 
taken by another user.  Please refer to Section 2.6.1 User Authentication Rules for details 
regarding the userid and password. 
 
Enter a codeword that you can remember. In the event that you forget your password, you 
may request for it to be reset based on this codeword. 
 
Click on Submit Registration to submit your request to EDIS E-Filing.  
 
For any mandatory fields that have not been filled, you may receive any of the following 
messages:  
 
You must enter a value for First Name.  
You must enter a value for Last Name.  
You must enter a Firm/Organization. 
Email is not formatted correctly. Please enter a properly formatted email address.  
You must enter a value for User ID.  
You must enter a value for Password.  
You must enter a value for Re-enter Password.  
You must enter a value for Codeword.  
 
Additional error messages may be displayed if the Firm/Organization address is 
incomplete or outside the United States. 
 
Reset Form will clear the data from the form. Data currently typed in the form will be 
lost. 
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The registration process continues in paragraph 2.6.2.3 Registration Confirmation and 
Notification. 
 

2.6.2.2.2 Internal User Registration 
The registration page for internal users has slightly different information as shown below, 
see Figure 8 - Registration - Internal User. 
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Figure 8 - Registration - Internal User 

Enter your full name as you would sign documents that you are submitting. When 
submitting documents, the signature names will need to match the registered name on the 
account submitting the documents. 
 
 
For internal users, the Firm/Organization is set to USITC and the USITC address. Enter 
mail routing or office number in the second Address field. 
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Select your Office/Division from the dropdown list.  EDIS E-Filing will allow you to 
modify the Office/Division for each document submitted in the event that you are 
supporting another Office for a specific investigation. 
 
Your email address must end in @usitc.gov. 
 
Enter your desired userid and password. An error will be noted if the userid has been 
taken by another user.  Please refer to Section 2.6.1 User Authentication Rules for details 
regarding the userid and password. 
 
Enter a codeword that you can remember. In the event that you forget your password, you 
may request for it to be reset based on this codeword. 
 
Click on Submit Registration to submit your request to EDIS E-Filing. 
  
For any mandatory fields that have not been filled, you may receive any of the following 
messages:  
 
You must enter a value for First Name.  
You must enter a value for Last Name.  
Email is not formatted correctly. Please enter a properly formatted email address.  
You must enter a value for User ID.  
You must enter a value for Password.  
You must enter a value for Re-enter Password.  
You must enter a value for Codeword.  
You must enter a value for internal division.  
 
Reset Form will clear the data from the form. Data currently typed in the form will be 
lost. 
 
The registration process continues in paragraph 2.6.2.3 Registration Confirmation and 
Notification. 

2.6.2.3 Registration Confirmation and Notification 
Upon clicking Submit Registration, a confirmation screen will be displayed, as shown in 
Figure 9 - Registration – Confirmation. 
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Figure 9 - Registration – Confirmation 

Click Make Changes if any of the information is incorrect. 
 
This page can be printed for safekeeping. Note that for security reasons neither the 
Codeword nor password is displayed on the confirmation screen. 
 
When you click Accept Information, you will be registered and automatically logged in 
to EDIS E-Filing.  
 
An email is sent to the email address specified on the Registration form to confirm your 
registration, as shown in Figure 10 - Registration Notification Email. 
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Figure 10 - Registration Notification Email 

 

2.6.3 Login 
Users are required to login to access the document filing and reporting functions. Click 
on the Login link to access the following screen, see Figure 11 - Login. 
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Figure 11 - Login 

 
Enter your Userid and Password in the fields provided, and click Submit. Reset Form will 
clear any entered data on the form. See 2.6.1 User Authentication Rules for information 
regarding userid and password rules. 
 
If your userid or password is incorrect, you will receive the message: (!) Some or all of 
the information that you have entered is incorrect. Please try again.  Verify that you 
are using the correct userid and password. Verify that CAPS LOCK is not on before re-
entering. 
 
You have 3 attempts to enter the correct password after which your account will be 
locked and you will need to contact the EDIS System Administrator at (202) 205-EDIS 
(3347) to unlock your account. The message: INFO: Password incorrect for the given 
login ID - account has been LOCKED. Please contact the USITC EDIS System 
Administrator for help. (202) 205-EDIS(3347). 
 
If you attempt to login and your account is already locked, you will receive the message: 
INFO: This account is currently LOCKED. Please contact the USITC EDIS System 
Administrator for help. (202) 205-EDIS(3347) 
 
If you attempt to login and your account is inactive, you will receive the message: INFO: 
This account is currently INACTIVE. Please contact the USITC EDIS System 
Administrator for help. (202) 205-EDIS(3347) 

Print Date: 7/18/2006 24 



  EDIS E-Filing 1.1 User Guide 

 
If you have forgotten the password, click Forgot Password to reset your password using 
your codeword. If your account is locked, you will NOT be able to activate your account 
using this option. 
 
If you receive the error message: A connection error has occurred trying to validate 
your entered data. Please try again later., the system is not operational, and the 
database connection cannot be established. You may contact the EDIS System 
Administrator to report this error. 

2.6.4 Change Password 
The Change Password option is available to permit you to change your password at any 
time. The Change Password screen is displayed automatically when your password 
expires or when you have reset your password to your codeword. The Change Password 
screen appears in Figure 12 - Change Password. 
 

 
Figure 12 - Change Password 

 
 
Enter your existing password in the Old Password field, and your desired new password 
in the New Password and Confirm Password fields. Click Submit to make the change. 
Reset Form will clear the entries from the form. 
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If the Old Password value is not the password in EDIS E-Filing, a message is displayed: 
(!) The password you have entered does not match your current password. 

If the New Password value does not conform to the password rules, a message is 
displayed: (!) The password must be between 8-30 characters long and contain upper 
or lower case letters (a-z), numbers (0-9)and special characters (&, ! , # etc.) but no 
spaces. 

If the New Password and the Confirm Password values do not match, a message is 
displayed: (!) The passwords do not match. Please re-enter correct password!  
 
If this page is opened as a result of Forgot Password, the Old Password field is labeled 
Codeword, and you must enter your Codeword as your old password. 

2.6.5 Forgot Password 
If you are logging in and have forgotten your password, your password can be reset to 
your codeword. The codeword is the word that you set during registration.  
 
From the Login screen, click Forgot Password, and the following screen will be displayed 
as shown in Figure 13 - Forgot Password. 
 

 
Figure 13 - Forgot Password 
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Enter your Email Address, User ID/Name and Codeword. Click Submit. If the User ID 
and Codeword match the values in the EDIS database, then your password will be reset to 
your Codeword. Reset Form will clear the entries from the form. 

If you entered an incorrect User ID, a message is displayed: (!) The login id, codeword 
combination does not match. Please try again.  

You cannot reset your password if you have locked your account by entering too many 
incorrect passwords. You cannot reset your password on an inactive account. A message 
is displayed: (!)This account is currently INACTIVE. Please contact the USITC 
EDIS System Administrator for help. (202) 205-EDIS(3347) 
 
In the event your account is locked or you have forgotten your userid, please contact the 
EDIS System Administrator at (202) 205-EDIS (3347). 
 
You will be required to immediately change your password upon successful login. See 
2.6.4 Change Password. 

2.7 Electronic Document Filing 
 
To file electronic documents with USITC, select E-File Documents after logging into 
EDIS E-Filing. You should have your documents ready to submit before entering EDIS 
E-Filing. The documents must be in PDF format and, if necessary, separated into 
attachments of 10MB or less.  There is no limit on the number of attachments that can be 
added.  

2.7.1 Preparing the Documents to Submit 
All documents submitted electronically to EDIS E-Filing must be prepared so that they 
are readable in Adobe Acrobat. Acrobat 4.0 is the minimally accepted format.  
 
There are several methods to prepare your document as an Adobe Acrobat PDF file.  

1. Create a document in word processing software and convert to PDF. 
2. Scan images and convert into PDF. 

 
Typically you will create the text of your document using word processing software, such 
as Microsoft Word or WordPerfect. Keep the settings and topics below in mind as you 
are creating the text, as it will minimize document rejections in EDIS E-Filing. 
 
The Handbook on Electronic Filing Procedures contains information regarding policy and 
document filing rules, such as page limits for certain documents and cover letter and 
signature requirements for document submissions. 
 
As you are creating your documents, be mindful of the file size of your Acrobat PDF 
converted document. You will need to break large submissions into manageable pieces 
which are less the 10 MB in size. In Windows explorer, you can set View -> Details to 
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see the file size. The size is not necessarily related to the page count of the document. 
Graphics and images can consume large amounts of space in your document.   
 
Below are some helpful hints to configure Word, Acrobat and WordPerfect. 
 
If creating the document in Microsoft Word and your workstation has Adobe Acrobat 
Standard or Professional installed on it, you may find Acrobat PDF options on the Menu 
Bar or icons on the toolbar to convert the document.  Before converting a document, 
select Adobe Acrobat -> Change Conversion Settings to review the options selected. See 
Figure 14 - Adobe Acrobat Conversion Settings for the Change Conversion Settings 
screen.  
 
For documents submitted to EDIS it is recommended that you uncheck Attach Source 
File to Adobe PDF and uncheck Add Links to Adobe PDF. 
 

 
Figure 14 - Adobe Acrobat Conversion Settings 
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Click Advanced Settings… See Figure 15 - Adobe Conversion Advanced Settings. 
 

 
Figure 15 - Adobe Conversion Advanced Settings 

The preferred Compatibility setting is Adobe Acrobat 6.0. Acrobat 4.0 (PDF 1.3 is the 
minimal setting). PDF 1.3 will generate the smallest file size but will lose more advanced 
features available. 
 
Click on the Fonts option. See Figure 16 - Adobe Conversion - Advanced Settings - 
Fonts. Ensure that Embed all Fonts is selected. 
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Figure 16 - Adobe Conversion - Advanced Settings - Fonts 

 
Click on the Security Tab as shown in Figure 17 - Adobe Conversion Settings - Security. 
Documents will not be accepted with either Password option enabled. 
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Figure 17 - Adobe Conversion Settings - Security 

 
Another option for converting Microsoft Word or WordPerfect documents is to use the 
Adobe Acrobat Printer option to convert the document. Tip: Before creating the text in 
the document, select File -> Print. On the Main tab, pick the Acrobat Printer as your 
default for the document. Upon selecting the Acrobat Printer, the page formats will be set 
correctly, and there will be fewer problems with footnotes and other page formatting 
when the document is converted to PDF. 
 
If you have various text sources or graphics which must be scanned, some scanners have 
the capability to scan the images directly into a PDF format. Use your scanner to create 
the PDF file from your document pages. 
 
If you have multiple document sources Adobe Acrobat Professional 7.0 has the capability 
to merge various source documents easily into one PDF File. Open the first source PDF 
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file. Using the Organizer Tool within Acrobat, insert the remaining files. An internal 
bookmark is created for the beginning of each file that was appended to the document. 
 
Remember to keep a local copy of your source Word or WordPerfect document if future 
edits are required, since formatting is usually lost in converting PDF documents back to 
Word or WordPerfect.  

2.7.2 PDF Validation Rules 
EDIS E-Filing will validate the PDF file submitted for the rules below. In general, for 
readability and security, your document must not contain any macros, external links, or 
dynamic links that would move the reader to another document. If your PDF file contains 
any of the following characteristics your document will be rejected.  
 
The file submitted must be a valid PDF file. You cannot rename another file extension to 
.pdf in order to submit an Adobe PDF file. You will receive the error message: Rejected: 
File does not appear to be a valid PDF. 

Table 1 - PDF Validation Rules 

Standard How to Detect the 
Problem 

How to Correct Your Source 
Document 

1. MUST be a valid PDF 
file of PDF version 1.3 or 
greater 

Your must have 
Acrobat 4.0 or greater. 
In Acrobat select File -> 
Document Properties on 
the Description Tab, 
check the PDF Version 
field. 

See instructions in 2.7.1 
Preparing the Documents to 
Submit. 

2. MUST have a PDF file 
security of “None” 

Error Messages: 1. 
Rejected – PDF is 
encrypted and cannot 
be processed or 2. 
Rejected - PDF is 
password-protected and 
fails PDF check. In 
Acrobat, check File -> 
Document Properties -> 
Security Tab to be set to 
No Security. 

See instructions in 2.7.1 
Preparing the Documents to 
Submit. The first message is 
due to the file having an Open 
password and the second 
message is due to the file 
having an Edit or Printing 
password. 

3. MUST NOT contain any 
embedded files 

Error Message: 
Rejected – File contains 
one or more embedded 
links. 

Embedded files should be 
copied into the document as 
Exhibits or Appendices to 
your filing.  

4. MUST NOT contain 
JavaScript Actions 

Error Message: 
Rejected – File contains 
JavaScript. 

Remove any macro coding or 
Form Actions from the 
document 
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5. MUST NOT contain 
External Cross 
References (web links 
and files) 

Error Message: 
Rejected – File contains 
one or more embedded 
links. 

Change the option to 
automatically generate web 
links for text ‘http… ‘ within 
your document. Similarly 
remove any file references 
such as ‘c:\my documents\…’ 

6. MUST NOT contain any 
PDF Comments (e.g. 
notes, files, sounds, etc.) 

Error Message: 
Rejected – File contains 
one or more popups. 
Check the Comments 
Tab in Acrobat left tab 
bar. 

Remove any notes, yellow 
stickies, review comments and 
other attachments from the 
document.  

7. MUST NOT contain any 
Form Actions 

Error Message: 
Rejected – File contains 
JavaScript. 

If the document is a form, 
form actions may be contained 
in it for automatic signatures 
or calculations from 
spreadsheets such as totals. 
These must be converted to 
text.  

8. MUST NOT contain any 
Type 3 Fonts  

RULE REMOVED IN 
RELEASE 1.1.3 
 

Type 3 Fonts are fonts 
that do not resize well 
and may not print 
correctly. 

Using your source Word / 
WordPerfect document, locate 
the text that is not a typical 
font (such as not Times New 
Roman, Courier New, or 
Arial) and change the text to a 
Printer or TrueType font. 
Later versions of Word will 
allow you to view all fonts 
used in the document to assist 
in identifying the offending 
font. Be cautious of submitting 
foreign language documents, 
since the intended audience 
for these documents may not 
have knowledge of the 
language, and it may require 
installation of foreign 
language support and fonts on 
the workstation. 

9. Unicode character sets 
RULE REMOVED IN 
RELEASE 1.1.3 

Error Message – 
Rejected -File contains 
a Unicode (Type0) font 
Unicode character sets 
cause similar issues to 
Type 3 Fonts. 

If using foreign language 
words, such as in titles of 
foreign companies, special 
characters are needed for 
certain accents. In Word 2003, 
for example, inserting a 
symbol may cause a problem 
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in the document if using 
Unicode(hex) as the character 
type. In this case, select 
Ascii(decimal) option. Earlier 
versions of Word do not have 
this character type option. 

 

2.7.3 Preparing the Tab Sheet (Internal USITC Use Only) 
These instructions are for setting up document printing information (specifically tab page 
inserts into printouts) for certain document submissions. For EDIS E-File Release 1.1, 
only USITC staff may initiate printing for internal distribution through EDIS E-
File.  
 
When electronic documents are submitted, certain Document Types filed in Section 337 
matters will be routed for printing to the Office of Publishing, before being approved by 
the Office of the Secretary. USITC will print the required internal distribution copies. For 
the document types identified in Table 2 - Document Types for Printing, these documents 
will be printed and distributed to General Counsel, Administrative Law Judges, and 
Office of Unfair Import Investigations (OUII) as required. 
 

Table 2 - Document Types for Printing 

Area of 
Interest 

Document Type Internal Use 
Only 

Print Copies (*) 

Sec 337 Motion 0 6 or 12 
Sec 337 Motion 

Response/Reply 
0 6 or 12 

Sec 337 Brief Filed with 
ALJ 

0 6 

Sec 337 Petition for Review 0 12 
Sec 337 Petition for Review, 

Response to 
0 12 

Sec 337 Brief on 
Review/Remedy 

0 12 

(*) –Sec 337 print plant rules require 12 copies be distributed if Before the 
Commission and 6 if Before ALJ.  

New Complaint and Petition print copies (12) must be provided by submitter. The 
original document is not included in this count (the electronic filing is 
considered the original). 

 
The distribution mix is: 
Section 337 – Before the Commission 12 
6 Commissioners 
2 GC 
1 INV 
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1 ID 
1 EC 
1 SEC 
 
Section 337 (6) Section 337 (4) Paper Reduction Proposal 
2 GC   1 GC 
2 OUII   1 OUII 
2 ALJ   2 ALJ 

 
Create the PDF documents for filing, by converting the Word or WordPerfect Document 
to Adobe Acrobat files; merging multiple PDFs, or scanning documents into PDF files. 
Whenever an Appendix or Exhibit is referenced include a separator page with EXHIBIT 
xx or APPENDIX bb.  
 
Once the PDFs have been created, an additional file is needed for the Tab Sheet.  Create a 
Tab Sheet to be attached as the last attachment on the Electronic Document Submission. 
The Tab Cover Sheet must contain the Investigation Title and Investigation Number, and 
include the page numbers where the Exhibit and Appendix separator pages occur within 
the document.  
 
If you do not include a Tab Sheet and your document is one of the types listed above, the 
document copies will be printed without additional tab separators added.  
 
For example,  
 
 
Title: Certain Frozen Warmwater Shrimp and Prawns from India and Thailand, Invs 751-28 
 
Document Test2Main: 
Appendix A – p.22 
Appendix B – p.40 
Appendix C – p.68 
 
Attachment  Test2Exh1red: 
Exhibit 1 – p.4 
Exhibit 2 – p.7 
Exhibit 3 – p.9 
Exhibit 4 – p.36 
 
END OF DOCUMENT 

Figure 18 - Sample Tab Sheet Content 

 
 
Next, Login to EDIS E-Filing, and select E-file Document. Fill in the correct data, and 
attach the document PDFs. The last file added should be the Tab Sheet. Label the 
Attachment Title as ‘Tab Sheet’.  
 
If the user selects Area of Interest: Section 337, then the user will be requested to select 
‘Before the Administrative Law Judge’ or ‘Before the Commission’. 
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When the document is submitted, the Publishing Office will receive an email with the 
documents attached. The documents and cover sheet will be printed based on the 
following schedule: 
 
Documents submitted by 12:00 noon will be distributed by 5:15 pm 
Documents submitted after 12:00 noon will be distributed by 10:30 am the next day. 

 
Note: The documents are being printed and distributed prior to approval by Dockets and 
the Office of the Secretary.  If the electronic filing data is incorrect or the attachments are 
incorrect, then there is a possibility that erroneous information has been provided to the 
Administrative Law Judge or Commission. Please contact Dockets at (202) 205-3347 
immediately if you have incorrectly filed the document or noticed that the document was 
rejected so that the distributed copies can be retracted. 
 
If the document is to be printed with Tab inserts, create a Tab Sheet and submit it as an 
additional attachment for the document you are submitting. If you do not include the Tab 
Sheet, and the document meets the criteria above, it will be printed and distributed 
without tabbed dividers. 
 
Within the document, insert a separator page identifying the Exhibit or Appendix. At a 
minimum, the page must state ‘Exhibit xx’ or ‘Appendix xx’ where xx is the appropriate 
number or alphabetic character as specified in the Handbook for Electronic Filing 
Procedures. You may also insert the title of the Exhibit or Appendix on this page and 
include horizontal lines as visual separators.  
 
Once you have converted the document to PDF, view the document in Acrobat. Locate 
the page numbers of the separator pages you inserted in your document. Tip: You may 
find the Pages tab in Acrobat useful for viewing the pages and page numbers. 
 
Convert this document to PDF and submit as an attachment. It is preferred to identify this 
document in EDIS E-Filing with the Attachment Title of ‘Tab Sheet’. 
 

2.7.4 Electronic Document Submission 
You must have signatory authority on the documents filed in order to submit documents 
through EDIS E-Filing.  Support staff will be required to submit documents using the 
userid and password provided by the attorney for the investigation.  
 
Select E-File Documents from the Main Menu. Notice that some fields have been 
populated and cannot be modified.  
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Figure 19 - Electronic Document Submission 

 
The name that appears on the Filed By field is the name of the attorney submitting the 
documents and must match the signature on the document submitted. This data uses the 
logged-in user’s registration information to populate the form. There are slight 
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differences in the data entry form depending on whether you are a registered internal or 
external user. See Figure 19 - Electronic Document Submission for an example. 
 
The Firm/Organization is the Law Firm, Corporation, or Organization of the user filing 
the document. For external filers, this is set to your Firm / Organization from your 
registration information. For internal users, the Firm / Organization defaults to USITC, 
but you may alter the Firm / Organization for the document you are submitting. Internal 
users should select Find Firm, and a list of firms will be displayed. Select the Firm name 
for which you are submitting the document. If the Firm is not on the list, you may type in 
the Firm name. We recommend using the Find Firm tool, so that the complete firm name 
can be used, with capitalization and consistent spelling. 
 
If an external user, you will be able to enter the Filed On Behalf Of field to indicate the 
company or organization you are representing. If you are an internal user, the Filed On 
Behalf Of field will default to the Office / Division that you registered under. The 
internal user may change this value if on detail to another Office.  
 
If Filed By, Filed On Behalf Of or Firm / Organization defaults are incorrect, please 
contact EDIS System Administrator (202-205-3347) to correct your registration 
information. 
 
Click on Find Investigation to select the investigation for this filing, or select New 
Request if you are filing a Complaint, Petition, or Request for Advisory Action. The 
Investigation Number field cannot be directly entered, you must select Find 
Investigation to populate the Investigation Number, Area of Interest, Investigation 
Phase, and Investigation Title. Please see paragraph 2.7.5 Find Investigation for 
assistance in finding the investigation. 
 
For internal users, if the document is a Section 337 filing, you will be requested to select 
whether this investigation is Before the Administrative Law Judge or Before the 
Commission. This information is not retained in EDIS, but it used to determine the 
number of distribution copies which must be printed. 
 
For internal users, if you are in the Office of Investigations and select an Import Injury 
investigation, you will have the option to select APO Release or not. Only Confidential 
documents may be submitted for APO Release. 
 
The Document Type list is filtered by the Area of Interest for the investigation chosen. 
Please select the investigation number first, then select the document type. 
 
The Security list varies depending on whether the user is internal or external. External 
users may only file Public documents electronically. Confidential documents must be 
submitted in paper, using the File Documents (Paper Only) main menu option. Internal 
users may file any security level document electronically. Some document types always 
require paper filings. Please consult the Handbook on Electronic Filing Procedures for 
policy. Be sure that your document text is marked appropriately if the document contains 
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Business Proprietary Information (BPI) or Confidential Business Information (CBI). Also 
verify that the text has been properly redacted for Public versions of Confidential 
documents. 
 
The Document Title may be left blank if the other information has sufficiently identified 
your submission.  Dockets will add information in the Document Title field according to 
rules established by Dockets and the Office of the Secretary. For example, Motion 
Numbers and Order Numbers are shown at the beginning of the Document Title field 
without an identifier on the number. 
 
The Document Date is the date the document was authored. For external filers, the 
Document Date is set to the date the cover sheet was generated. For internal filers, it 
defaults to today’s date but may be changed to the date that correctly matches the 
document being filed. 
 
For electronic filing, the attachments must be uploaded from your system to USITC. 
Each attachment must be an Acrobat PDF file, not larger than 10 MB on each attachment 
and conform to the PDF rules in Paragraph 2.7.2 PDF Validation Rules. 
 
To attach files to the electronic submission, click Browse… A popup window is 
displayed for you to locate your file to submit. Click on the file, and click Open to select 
it. The file name with the path will be shown on the document submission screen. You 
may add an identifying Attachment Title for each file. For example, the Attachment 
Title should identify the range of exhibits in each attachment. Click Attach Files to 
upload each file. Repeat this process to add other attachments. Each attachment (section) 
to be submitted must be selected individually. Repeat Browse and the selection of an 
attachment as many times as needed to attach all document sections for this filing. 
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Figure 20 - Browse - Select Attachment 

 
As each attachment is being uploaded to USITC, the following window will be displayed 
briefly. (See Figure 21 - File Upload ) 
 
 
 

 
Figure 21 - File Upload 

 
If any files are greater than 10MB in size, you will receive an error message, and will 
have to re-submit your data and documents. 
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Once the files are successfully uploaded, click Submit Document w/ Attachments to 
begin the submission process.  An EDIS Document Submission Confirmation will be 
displayed (See Figure 22 - Electronic Submission Confirmation.) Note: The document 
has not been accepted by EDIS unless you click on Accept Information on the 
bottom of this screen. 
 
If you wish to start over and not submit the document, Reset Form will clear the data 
you entered from the form. 
 
 

 
Figure 22 - Electronic Submission Confirmation 
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Once you click Accept Information, the Notice of Receipt confirmation will be displayed 
(See Figure 23 - Electronic Submission - Notice of Receipt ) NOTICE: YOUR 
DOCUMENT WAS NOT SUBMITTED UNTIL THE SCREEN BELOW IS 
DISPLAYED. 
 
 

 
Figure 23 - Electronic Submission - Notice of Receipt 

 
Once the document has been processed into the system, you will receive an email notice 
about the acceptance or rejection of your filing based on the PDF Rules defined above. If 
your document is rejected, you must resubmit the entire document (all attachments) again 
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with the errors corrected. Below are samples of Accepted and Rejected notices (See 
Figure 24 - Electronic Filing Accepted Email and Figure 25 - Electronic Filing Rejection 
Email). 
 
If you wish to file another document with similar information, please select File Another 
Document. Do NOT use the Back button as this may cause your document submission to 
fail. 
 
Below is an example of a successful email notice of filing. Note that the Subject of the 
document is Accepted EDIS Document – Receipt. At the end of the email message you 
will see that each attachment was successfully processed. 
 

 
 

Figure 24 - Electronic Filing Accepted Email 

 
If any attachment or section of the document contains errors in the PDF standards, the 
entire document will be rejected. The filer must correct the problem and resubmit the 
entire filing. The email notice identifies the rejection in the Subject line - Rejected EDIS 
Document – Receipt. View the end of the email for the specific error encountered. 
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Figure 25 - Electronic Filing Rejection Email 

Once the document is submitted to USITC, there is a three-step approval process that the 
document must go through to be fully accepted by USITC. These steps include Verify 
Document and Data, Rules Compliance and Quality Check. Once the document has been 
finally approved through these three steps, another email will be sent. Only after the 
document is approved, will the document be inserted into the Search Application, and be 
made available for Public search. 
 
 

2.7.5 Find Investigation 
On Electronic Document Submission and Paper Cover Sheet Creation, the user must 
select an Investigation to file the document under. The popup screen below appears on 
clicking Find Investigation (See Figure 26 - Find Investigation ) 
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Figure 26 - Find Investigation 

Enter any criteria to filter the result list, and click Find Investigation. A screen for Figure 
27 - Find Investigation after Search is shown. Reset Form will clear any entries on Find 
Investigation. Close Window will result the user back to the Document Submission or 
Cover Sheet Creation page. 

 
Figure 27 - Find Investigation after Search 

Click the button beside the investigation, to select it. Scroll down and click Select to 
return the investigation data back to the Document Submission or Cover Sheet page. You 
will be requested to confirm this selection. Click OK.  This will return the Investigation 
Number, Phase, Area of Interest and Investigation Title. Based on the Area of Interest, 
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the Document Type Dropdown list will be updated, and unique data for processing 
Section 337s or APO Releases will be shown. 
 

2.8 Paper Document Filing 
Paper document filing means that the document you are filing will be submitted to 
USITC in hardcopy for scanning and insertion into EDIS.  In order to file a paper 
document, the user must login and create a Cover Sheet describing the document being 
submitted.  See Figure 28 - Paper Document Submission. The Cover Sheet must be 
printed and attached to the document being submitted.  
 
Please follow the EDIS filing rules found in the Handbook for Electronic Filing 
Procedures for guidance regarding the number of copies and format of documents that 
will be accepted by USITC. 
 
Select File Documents (Paper Only) from the Main Menu. The guidance for creating 
the coversheet is the same as those for Electronic Filing. Please refer to Paragraph 2.7.4 
Electronic Document Submission for explanations on the document fields, with the 
exceptions as below: 

1. External users can select Public or Confidential for the Security level for 
paper submissions. 

2. The internal print production option on Section 337 documents is not 
available for paper submissions. 
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Figure 28 - Paper Document Submission 

 
 
When you have filled the form, please click on Create Cover Sheet. If you wish to erase 
the data from the form and begin again, click Reset Form. 
 
The following confirmation screen is displayed, so that you may visually validated the 
data being generated for the cover sheet. (See Figure 29 - Cover Sheet Confirmation 
Screen) 
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Figure 29 - Cover Sheet Confirmation Screen 

Click Accept Information once your data is verified. If an error is noted, click on Make 
Changes. Do not use the browser back button, as this may cause your cover sheet 
creation to fail.  
 
The screen below will be displayed with the barcode for your document. YOU MUST 
PRINT OUT THIS SCREEN TO ATTACH TO THE PAPER COPIES OF YOUR 
DOCUMENT. (See Figure 30 - EDIS Cover Sheet to Accompany Hard Copy 
Submission) 
 
Use File -> Print from your browser menu or use the Print Page button on the bottom of 
the screen to print the Cover Sheet. 
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Figure 30 - EDIS Cover Sheet to Accompany Hard Copy Submission 

If you wish to file another document with the same attributes, select File Another 
Document. Otherwise, you may select any option from the EDIS Tools menu. 
 
Shortly after you have completed the Cover Sheet process, you will receive an email to 
confirm the entry of the Cover Sheet information in EDIS. (See Figure 31 - Cover Sheet 
Confirmation Email). 
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Figure 31 - Cover Sheet Confirmation Email 

 
If the print out of the Cover Sheet with barcode was not done or lost, a printout of this 
email receipt may be accepted by the Dockets Office for submission. 
 
You should bring your Cover Sheet and Documents to the USITC Dockets Office, Room 
112, for processing. 
 

2.9 EDIS Document Approval Processing 
Once the document has been filed, either electronically or by paper submission, the 
Dockets Office will begin processing the document. 
 
The document submission is validated to ensure that the correct attachments are provided 
and that the correct number of copies has been submitted. The data on the Cover Sheet is 
validated by the Dockets staff to ensure that the document is correctly coded.  Once the 
document has been validated for quality and rules compliance, the document submission 
is approved. On approval, the document is made visible to users to search.  
Additional processing may be performed for printing and distribution. 
 
If an error is found following a document submission, please contact the EDIS System 
Administrator at (202) 205-3347 (EDIS).  
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2.10 Reports 

2.10.1 Daily Filing Report 
The Daily Filing Report provides the user with a report listing document submissions 
over a range of dates and/or for an investigation.  
 
Select Daily Filing Report from the EDIS Tools. See Figure 32 - Daily Filing Report - 
Parameters. 
 
The report parameters will default to show all documents filed within the past two 
business days (midnight yesterday to 11:59 pm today).  You can click Submit Query to 
activate this report without entering additional parameters. 
 
If you need a longer range of dates, you may select from the dropdown list for Filed on or 
after a date, or Filed on or before a date. You may also expand the date range by entering 
a new date in the format mm/dd/yyyy or by clicking on the calendar icon and picking the 
date. The report is limited to a 30 day range. 
 
If you would like to filter the report by Investigation, please enter the investigation 
number and if desired, please select the Investigation Phase. 
 
Click Submit Query to execute the report. 
 

 
Figure 32 - Daily Filing Report - Parameters 
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The report will be displayed. See Figure 33 - Daily Filing Report. 
 
For external users, only document data for documents with Security Level of Limited or 
lower will be displayed. Internal users will see all filed document data. Cover Sheets that 
have been submitted but not processed through scanning will not be displayed.  
 

 
Figure 33 - Daily Filing Report 

To navigate through the pages of the report, scroll down and select First, Previous, Next 
or Last. Scroll right to see the remainder of each page.  
 
 
 

To print the report, click the Download PDF Report  
button (upper right corner of page). The report will be converted to PDF and displayed. 
The user will have the normal printing and formatting options available in Acrobat to 
print the document. 
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To view more detail about the document, click on the hyperlink on the Document ID 
number. The Section Subreport will be displayed. See Figure 34 - Daily Filing Report – 
Sections below. 
 

 
Figure 34 - Daily Filing Report – Sections 

If the document has multiple sections the list of sections will be shown. Click on the 
Section ID hyperlink to view the section. This requires that you have Adobe Acrobat 
Reader to view the document. If the document has not been fully processed through EDIS 
or the document is not a PDF, a notice will appear that the document is not available. 
Only Public documents will be displayed to users. 

2.10.2 Service List  
The Service List option is available to the users as a quick search to locate the latest 
Public Service List or APO Service List for an Import Injury investigation.  See  
 
Enter the criteria for the investigation (Investigation Number, Phase, Area of Interest). 
Click Submit Query. 
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Figure 35 - Service List - Investigation Search Parameters 

 
Select the investigation from the result list. Select the desired Service List by clicking on 
the hyperlink on the investigation number. If more than one page of results is returned, 
the pages may be navigated using the options on the bottom of the list.  (See Figure 36 - 
Service List - Investigation List below) 
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Figure 36 - Service List - Investigation List 

 
Upon selecting the investigation, if Service Lists are available in EDIS, links to the APO 
Service List and the Public Service List will be shown. 
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Figure 37 - Service List 

Click on the desired document, and a window will open in Adobe Acrobat with the 
Service List document. 
 
If you need to locate a prior Service List for an investigation, please use the EDIS Search 
Options menu. 
 
If you are looking for a recent Service List on Anti-dumping or Countervailing or Five-
year Sunset Reviews, you may also look at 
http://www.usitc.gov/secretary/fed_reg_notices/serv_lists.htm . 
 
 

2.11 Link to Legacy EDIS II 
Access to the Legacy EDIS II system is only available to internal users with userids 
enabled for the EDIS II system. The link to the Legacy EDIS II system is provided for 
internal users to search for sensitive documents. 
 
Once you have accessed the screen below, you have left EDIS E-Filing. (See Figure 38 - 
Login to Legacy EDIS II below.) 
 

Print Date: 7/18/2006 56 

http://www.usitc.gov/secretary/fed_reg_notices/serv_lists.htm


  EDIS E-Filing 1.1 User Guide 

 
Figure 38 - Login to Legacy EDIS II 

Enter your userid and password. This may be the same userid and password that you are 
currently using on EDIS E-Filing. Click Login to access the Search tool for internal users. 
 

2.12 Link to Search  
 
The link, ‘Search’ connects the user to the EDIS Search tool, for public document 
searches. This tool is available to internal and external users. Only Public documents are 
searchable. Information on confidential documents is available, without retrieval of the 
document files. Internal users may use the Legacy EDIS II link to access sensitive 
documents. (See Figure 39 - Search Integration Menu below) 
 
Once you have clicked on the link to Search Integration, you have left EDIS E-Filing. 
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Figure 39 - Search Integration Menu 

2.13 RSS Generator 
 
Internal users may set up a notification service to be notified as each document is 
submitted into EDIS. The notification service is configure with Outlook, and the user can 
select an Area of Interest or Investigation to receive notices. Please see the RSS User’s 
Guide under the Help Menu for installation details. 
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Appendix A – Glossary 
 
Abbreviation Description
  
ALJ Office of the Administrative Law Judges 
APO Administrative Protective Order 
BPI Business Proprietary Information  
CBI Confidential Business Information 
CIO or OCIO Chief Information Officer 
COMM Commissioners 

DOCID Document Identification 
ECON Office of Economics 
EDIS Electronic Document Imaging System 
ER or OER Office of External Relations 
FAST Fast Data Search Engine 
GC or OGC Office of General Counsel 
OID Office of Industries  
OIG Office of Inspector General 
OINV Office of Investigations 
OITS Office of Information Technology Services  
OSE Office of the Secretary 
OTATA Office of Tariff Affairs and Trade Agreements 
OUII Office of Unfair Import Investigations 
PUB Office of Publishing 
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Appendix B – AOI Mapping to Document Type 
 
The following table shows the valid document types which may be submitted for each 
Area of Interest (AOI). There are a few document types which are not associated with an 
AOI, and cannot be used in document submission. The list is maintained in the database 
table ITC_AREA_DOCTYPE. 
 

Table 3 - AOI to Document Type Mapping 

 
AREA_OF_INTEREST DOC_TYPE DOC_DESC INTERNAL_USE
Byrd Amendment Action Jacket There include all action jackets 1 
Byrd Amendment Correspondence Emails, Letters, FAXes, Telegrams 0 
Byrd Amendment Hearing Material - Request 

to Appear/Witness List 
For Conferences and Hearings 0 

Byrd Amendment Memorandum Memorandum 0 
Byrd Amendment Other Not Included 

Elsewhere/Miscellaneous 
0 

Byrd Amendment Request Letter  0 
Byrd Amendment Verification Report  1 
Byrd Amendment Voting Sheet Public Record of Notational Voting 0 
Genl Factfinding Action Jacket There include all action jackets 1 
Genl Factfinding Action Request  0 
Genl Factfinding Brief - Other  0 
Genl Factfinding Brief - Post-

Hearing/Conference 
 0 

Genl Factfinding Brief - Pre-Hearing  0 
Genl Factfinding Correspondence Emails, Letters, FAXes, Telegrams 0 
Genl Factfinding Hearing Material - 

Exhibits/Testimony 
For Conferences and Hearings 0 

Genl Factfinding Hearing Material - Request 
to Appear/Witness List 

For Conferences and Hearings 0 

Genl Factfinding Hearing Material - Staff 
Question 

Hearing Material - Staff Question 0 

Genl Factfinding Mailing List  1 
Genl Factfinding Memorandum Memorandum 0 
Genl Factfinding News Release News Release filed by OER 0 
Genl Factfinding Notice Includes Fed Register 0 
Genl Factfinding Opinion, Court  0 
Genl Factfinding Other Not Included 

Elsewhere/Miscellaneous 
0 

Genl Factfinding Publication - USITC USITC Publication (Final Report) 0 
Genl Factfinding Questionnaire - Foreign 

Producer 
Questionnaire - Foreign Producer 1 

Genl Factfinding Questionnaire - Importer Questionnaire - Importer 1 
Genl Factfinding Questionnaire - Purchaser Questionnaire - Purchaser 1 
Genl Factfinding Questionnaire - U.S. 

Producer 
Questionnaire - U.S. Producer 1 
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AREA_OF_INTEREST DOC_TYPE DOC_DESC INTERNAL_USE
Genl Factfinding Request Letter  0 
Genl Factfinding Service-Related Document  0 
Genl Factfinding Staff Report - Final (Sec 332 

or 1205) 
AJ Version 1 

Genl Factfinding Staff Report - Pre-Hearing  1 
Genl Factfinding Telephone/Meeting/Trip 

Notes 
 1 

Genl Factfinding Transcript Transcript 0 
Genl Factfinding Transcript - Corrections 

Request 
 0 

Genl Factfinding Voting Sheet Public Record of Notational Voting 0 
Genl Factfinding Work Sheet  1 
Import Injury Action Jacket There include all action jackets 1 
Import Injury Action Request  0 
Import Injury Brief - Other  0 
Import Injury Brief - Post-

Hearing/Conference 
 0 

Import Injury Brief - Pre-Hearing  0 
Import Injury Comments on Adequacy Sunset Reviews 0 
Import Injury Correspondence Emails, Letters, FAXes, Telegrams 0 
Import Injury Customs Net Import File  1 
Import Injury Entry of Appearance  0 
Import Injury Final Comments  0 
Import Injury Hearing Material - 

Exhibits/Testimony 
For Conferences and Hearings 0 

Import Injury Hearing Material - Request 
to Appear/Witness List 

For Conferences and Hearings 0 

Import Injury Hearing Material - Staff 
Question 

Hearing Material - Staff Question 0 

Import Injury Identification of Experts Identification of Experts 0 
Import Injury Mailing List  1 
Import Injury Memorandum Memorandum 0 
Import Injury News Release News Release filed by OER 0 
Import Injury Notice Includes Fed Register 0 
Import Injury Notice of Prior Art Notice of Prior Art 0 
Import Injury Opinion, Commission Opinion, Commission 0 
Import Injury Other Not Included 

Elsewhere/Miscellaneous 
0 

Import Injury Petition  0 
Import Injury Protective Order Protective Order 0 
Import Injury Protective Order Certification 

of Destruction 
 0 

Import Injury Protective Order Request  0 
Import Injury Protective Order Request 

Amendment 
 0 

Import Injury Publication - USITC USITC Publication (Final Report) 0 
Import Injury Questionnaire - Foreign 

Producer 
Questionnaire - Foreign Producer 1 

Import Injury Questionnaire - Importer Questionnaire - Importer 1 
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AREA_OF_INTEREST DOC_TYPE DOC_DESC INTERNAL_USE
Import Injury Questionnaire - Purchaser Questionnaire - Purchaser 1 
Import Injury Questionnaire - U.S. 

Producer 
Questionnaire - U.S. Producer 1 

Import Injury Response to Notice of 
Institution 

Sunset Reviews 0 

Import Injury Service List - APO Protective Order Service List 0 
Import Injury Service List - Public Public Service List 0 
Import Injury Service-Related Document  0 
Import Injury Staff Report - Final (Import 

Injury) 
 1 

Import Injury Staff Report - Pre-Hearing  1 
Import Injury Telephone/Meeting/Trip 

Notes 
 1 

Import Injury Transcript Transcript 0 
Import Injury Transcript - Corrections 

Request 
 0 

Import Injury Verification Report  1 
Import Injury Voting Sheet Public Record of Notational Voting 0 
Import Injury Work Sheet  1 
Rule Making Action Jacket There include all action jackets 1 
Rule Making Answer to Complaint  0 
Rule Making Comments/Response to 

Comments 
Comments/Response to 
Comments 

0 

Rule Making Hearing Material - 
Exhibits/Testimony 

For Conferences and Hearings 0 

Rule Making Hearing Material - Request 
to Appear/Witness List 

For Conferences and Hearings 0 

Rule Making Notice Includes Fed Register 0 
Rule Making Work Sheet  1 
Sec 337 Action Jacket There include all action jackets 1 
Sec 337 Action Request  0 
Sec 337 Answer to Complaint  0 
Sec 337 Brief Filed With ALJ  Including Proposed FF and CL 0 
Sec 337 Brief on Review/Remedy  0 
Sec 337 Certified Mailing List Certified Mailing List 0 
Sec 337 Comments/Response to 

Comments 
Comments/Response to 
Comments 

0 

Sec 337 Complaint  0 
Sec 337 Compliance Report  0 
Sec 337 Correspondence Emails, Letters, FAXes, Telegrams 0 
Sec 337 Discovery Statement Discovery Statement 0 
Sec 337 Entry of Appearance  0 
Sec 337 Exhibit, Post-Trial   0 
Sec 337 Exhibit, Pre-Trial  Including Objections & Exhib. Lists 0 
Sec 337 ID/RD - Final on Violation ID/RD - Final on Violation 0 
Sec 337 ID/RD - Other Than Final on 

Violation 
ID/RD - Other Than Final on 
Violation 

0 

Sec 337 Memorandum Memorandum 0 
Sec 337 Motion  0 
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AREA_OF_INTEREST DOC_TYPE DOC_DESC INTERNAL_USE
Sec 337 Motion Response/Reply  0 
Sec 337 News Release News Release filed by OER 0 
Sec 337 Notice Includes Fed Register 0 
Sec 337 Notice of Prior Art Notice of Prior Art 0 
Sec 337 Opinion, Commission Opinion, Commission 0 
Sec 337 Order Order 0 
Sec 337 Other Not Included 

Elsewhere/Miscellaneous 
0 

Sec 337 PO Subscription  0 
Sec 337 Petition for Review  0 
Sec 337 Petition for Review, 

Response to 
 0 

Sec 337 Publication - USITC USITC Publication (Final Report) 0 
Sec 337 Response/Submission to 

ALJ Order 
Also Includes Notice of Prior art, 
Identification of Witnesses, Expert 
Reports 

0 

Sec 337 Service-Related Document  0 
Sec 337 Transcript Transcript 0 
Sec 337 Voting Sheet Public Record of Notational Voting 0 
Test1 Other Not Included 

Elsewhere/Miscellaneous 
0 

Not Associated with 
AOI 

Appeal   

Not Associated with 
AOI Brief/Submission 

  

Not Associated with 
AOI Scheduling Order 
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